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PREFACE

Thank you for purchasing the TV-IP110WN Wireless N Internet Camera
Server, a powerful and high-quality image network camera. The camera
can be installed as a standalone system within your application
environment easily and quickly, and supports remote management
function so that you can access and control it using a Web browser on your
computer.

This guide will provide you more information of instruction and
illustrations on how to use your camera, which includes:

Chapter 1 Introduction to Your Camera describes the features of the
camera. You will also know the components and functions of
the camera.

Chapter 2  Hardware Installation helps you install the camera according
to your application environment. You can use this camera at
home, at work, at any where you want.

Chapter 3  Accessing the Camera lets you start using your camera
without problem. The camera can be set up easily and work
within your network environment instantly.

Chapter 4  Configuring the Camera guides you through the configuration
of the camera using the web browser on your PC.

Chapter5 SecurView™ Pro shows you the detail instructions on
operating SecurView™ Pro software.

Chapter 6 How to Access the Camera Behind a Router provides the
instruction how to setup your DDNS.

Chapter 7 Appendix provides the specification of the camera and some
useful information for using your camera.

NOTE: The illustrations and configuration values in this guide are for reference
only. The actual settings will depend on your practical application of the
camera.
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CHAPTER 1

INTRODUCTION TO YOUR CAMERA

1.1 Checking the Package Contents

Check the items contained in the package carefully. You should have the
following:

e 1xTV-IP110WN

e 1xCD-ROM (Utility & User’s Guide)

e 1 x Multi-Language Quick Installation Guide

e 1xExternal antenna

e 1x5V 2.5A power adapter

e 1 x Network Cable

e 1 x Camera Stand

NOTE: If there is any item damage or missing, please contact your local
authorized dealer for replacement.



1.2 Getting to Know Your Camera

|

Built-in Mic. Power LED

Link LED

Lens

TRENDNET

TVP110WN

e———— Detachable Antenna
Camera Stand Connector

Reset Button

Power

Connector LAN Port




Power LED: A steady orange light indicates the camera is powered
on.

Link LED: A flash green light indicates the camera’s network
connection correctly.

Lens: Adjust the focus by rotate outside of the Lens.

WPS button: A quick connection button to your encrypted
wireless network

Detachable Antenna:
Adjust the antenna position to get the maximum signal.

Camera Stand Connector: Connects the camera with the camera
stand.

Power Connector: Connects the power adapter in order to supply
the power to the camera.

LAN Port: Connects one end of the Network cable to LAN port and
connect the other end cable to your network

Reset Button: Press the reset button once to reset the current
setting. Press the reset button continuously for 5 seconds to
restore the camera to factory default setting.



1.3 Features and Benefits

Surveillance Supported

Enable motion detection and setup automated email alerts and upload
the still image into FTP.

Remote Control Supported

By using a standard Web browser or the included SecurView Pro
software application, the administrator can easily change the
configuration of the camera via Intranet or Internet. In addition, the
camera can be upgraded remotely when a new firmware is available.
The users are also allowed to monitor the image and take snapshots
via the network.

Multiple Platforms Supported

The camera supports multiple network protocols, including TCP/IP,
SMTP e-mail*, HTTP, and other Internet related protocols. Therefore,
you can use the camera in a mixed operating system environment,
such as Windows Vista and Windows 7.

Multiple Applications Supported

Through the remote access technology, you can use the cameras to
monitor various objects and places for your own purposes.

For example, babies at home, patients in the hospital, offices and
banks, and more. The camera can capture both still images and video
clips, so that you can keep the archives and restore them at any time.

WPS Supported

WPS (Wi-Fi Protected Setup) standard is a new solution that simplifies
the process of configuring Wi-Fi security settings, allowing you to
establish a secure wireless network by simply pressing a button.



1.4 System Requirement

B Networking

LAN: 10Base-T Ethernet or 100Base-TX Fast Ethernet,
Auto-MDIX

WLAN: Based on IEEE 802.11n technology, IEEE 802.11g/b

B Accessing the Camera using Web Browser

Platform: Microsoft® Windows® 7/Vista/XP

CPU: Intel Pentium Il 800MHz or above

RAM: 512MB

Resolution: 800x600 or above

User Interface:  Microsoft® Internet Explorer 6.0 or above

B Accessing the Camera using SecurView Pro

Platform: Microsoft® Windows® 7/Vista/XP
Hardware Requirement:

1~ 8 cameras: Intel Core 2 Duo; 2GB RAM
9 ~ 32 cameras: Intel Core 2 Quad; 4GB RAM

NOTE: It is higher recommended that using a high performance computer
to monitor multiple cameras.



CHAPTER 2

HARDWARE INSTALLATION

2.1 Installing the Camera Stand

The camera comes with a camera stand, which uses a swivel ball screw
head to lock to the camera’s screw hole. When the camera stand is

attached, you can place the camera anywhere by mounting the camera
through the three screw holes located in the base of the camera stand.

g
W
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The Camera Stand



2.2 Connecting the Camera to LAN

Use the provided Ethernet cable to
connect the camera to your local area
network (LAN). i

When you connect the power |
adapter, the camera is powered on
automatically. You can verify the
power status from the Power LED
(amber) on the front panel of the
camera.

Once connected, the Link LED starts
flashing green light and the camera is
on standby and ready for use now.

If you use a wireless network in your L
application environment, you need to | |
attach the included detachable ‘

antenna to the camera.

THIITE

If your wireless network has set
encryption, you can use WPS button
or configure the wireless connection
via a LAN connection.

.'
)

LI, L UL, 0, 8, 1

NOTE: Please configure the wireless setting via the wire connection.
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2.3 Applications of the Camera
The camera can be applied in multiple applications, including:

B Monitor local and remote places and objects via Internet or Intranet
B Capture still images and video clips remotely

B Upload images or send email messages with the still images attached

The following diagram explains one of the typical applications for your
camera and provides a basic example for installing the camera.

Mobile Phone

-11-



CHAPTER 3

ACCESSING THE CAMERA

3.1 Using IP Setup

The camera comes with a conveniently utility, IP Setup, which is included
in the Installation CD-ROM, allowing you to search the camera on your
network easily.

1. Insert the Installation CD-ROM into your computer’s CD-ROM drive to
initiate the Auto-Run program.

@ TRenDneT

IP Setup

SecurView Pro

User's Guide

Product Registration

F——
SecurView Wireless N
Internet Camera
TV-P110WN

© Copyright 2011 TRENDnet. All Rights Reserved.
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2. Click Install to install the IPsetup.

&# Setup - IPSetup _‘

Ready to Install
Setup is now ready to begin installing IPSetup on your computer.

Click Install to continue with the installation.

Cancel

3. Click Finish to finish the installation.
& Setup - IPSetup @Zl'—J

Completing the IPSetup Setup
Wizard

Setup has finished installing TPSetup on your computer. The
application may be launched by selecting the installed icons.

Click Finish to exit Setup.
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4. Afterinstalling the IPSetup utility, the application is automatically
installed to your computer, and creates a folder in “Start
\Program\TRENDnet\IPSetup” .

5. Click Start > Programs > TRENDnet > IPSetup, and then click IPSetup
| . TRENDnet ‘7‘

| IPSetup
& IPSetup

4 Back

| Search programs and files L |
ehlo :

6. The IPSetup window will appear. It will search the Camera within the
same network.

& IPSetup ﬂ
IP Address Device Name MAC Address
192.168.10.30 TV-IP110WN 00:FF:00:00:00:00
Change IP Search Exit

-14 -



Camera Display Area: It shows the connected camera(s) within the
same network. By default, the IP setting on the Camera is set up DHCP.
If you have DHCP server, the camera will automatic get the IP address
from DHCP server. If you do not have DHCP server on your network, it
will show the default IP as 192.168.10.30.

Double click the IP address; it will link to Camera’s Web Configuration
page.

Change IP: Click this button to bring up the following window. It
allows you to change the IP Address. You can select either Static IP or
click DHCP. Then, enter the Administrator ID & password. By default
ID/password is: admin. When complete, click “Change”.

Change [P Address B — ﬁ
@ Static IP
IP Address 192 . 168 . 10 . 1
Submask 255 . 255 . 255 . 0
Default gateway 192 . 168 . 10 . 100
DHCP

Administrator I & Password

D

Password

[ Change || Exit |

Search: Click this button to search the connected camera in the
same network.”

Exit: Click this button to exit the program.
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3.2 Accessing to the Camera

1. Open the Web browser on your computer (example showed in the
User’s Guide is based on the Internet Explorer)

2. Type the Camera IP address that DHCP server assigned in the web
browser URL (e.g. 192.168.10.30) and then press [Enter].

e New Tab - Windows Internet Explore

3. When the login window appears, enter the default User name (admin)
and password (admin) and press OK to access to the main screen of

the camera’s Web Configuration.
T Al
5

@ 192.168.10.30

-
Windows Security

The server 192.168.10.30 at netcam reguires a username and password.

Warning: This server is requesting that your username and password be
sent in an insecure manner (basic authentication without a secure
connection).

‘ admin |

‘ LITTIT] |

[ Remember my credentials

[ ok [ cancel |

NOTE: If you are initially access to the camera, you will be asked to install
a new plug-in for the camera. Permission request depends on the
Internet security settings of your computer. Click Yes to proceed.
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After you login into the Web Configuration of the camera, the main page
will appear as below:

@ TRENDNET Camera Information  [SESRSR,
TV-IP110WN
m Location:  2011/05/09 12:42:57

&> Live View [ax [ 2x [ 3x ]

Live View/ Setup

Manual Record
Snapshot 3 )
Browse Live View Image

Listen

L
i

Copyright © 2011 TRENDnet. All Rights Reserved.

The main page of the Web Configuration provides you with many useful
information and functions, including:

B Camera Information — Display the camera’s location and the current
date & time. The information can be modified in the Web
Configuration.

B Live View Image — Displays the real-time image of the connected
camera.

B Zoom In — Click the buttons to zoom in the live view image by 1x, 2x,
and 3x.
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B Live View/Setup Switch — Click Setup to configure the camera. Please
refer to Chapter 4 for more information.

B Function — Use these buttons to control the video functions.

NOTE:

Manual Record allows you to record and save a video clip.
Snapshot allows you to capture and save a still image.

Browse allows assign the destination folder to store the video
clips and still images.

If you are using Microsoft 7/Vista platform, you may not be able
to find these recorded files that are stored by Snapshot or
Manual Record. You will need to disable the protected mode of
Security in the IE Browser before manual record video file or
taking a snapshot.

Please follow the below Steps:

1. Open IE Browser

2. Select Tools=> Internet Options

3. Select Security

4. Uncheck the "Enable Protected Mode” then press OK

-18 -



3.3 Configuring the IP Address of the PC

If you are failed to access to the camera, please check the IP address of
your computer. When you connect the camera to your computer directly
to proceed with configuration of the camera, you need to set up the IP
addresses to be in the same segment for the two devices to communicate.

1. Onyour computer, click Start > Control Panel to open the Control
Panel window.

2. Double-click Network Connection to open the Network Connection
window.

3. Right-click Local Area Connection and then click Properties from the
shortcut menu.

4. When the Local Area Connection Properties window appears, select
the General tab.

5. Select Internet Protocol [TCP/IP] and then click Properties to bring up
the Internet Protocol [TCP/IP] Properties window.

6. To configure a fixed IP address that is within the segment of the
camera, select the Use the following IP address option. Then, enter an
IP address into the empty field.

7. When you are finished, click OK.

-19-



CHAPTER 4

CONFIGURATION OF THE CAMERA

4.1 Using the Web Configuration

You can access and manage the camera through the Web browser and the
provided software application SecurView Pro. This chapter describes the
Web Configuration, and guides you through the configuration of the
camera by using the web browser.

To configure the camera, click Setup on the main page of Web
Configuration. The Web Configuration will start from the Basic page.

@ TREnDnET SecurView Wireless N Internet Camera
TV-IP110WN

Location:  2006/12/31 16:00:31

Basic » System
Basi

Camera Name:
Smart Wizard e ve

Indication LED

Basic
Indication LED control: @ Normal [Z) OFF

T
Network

P
Video

P ———
Event Server

T —
Motion Detect

————
Event Config

T
Tools

P —
Device'Info

Copyright & 2011 TRENDnet. All Rights Reserved.

The Web Configuration contains the settings that are required for the
camera in the left menu bar, including Smart Wizard, Basic, Network,
Video, Event Server, Motion detect, Event Config, Tools, and Device Info.
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4.2 Using Smart Wizard

The camera’s Smart Wizard lets you configure your camera easily and
quickly. The wizard will guide you through the necessary settings with
detailed instructions on each step.

To start the wizard, click Smart Wizard in the left menu bar.

@ TRE“D“ET SecurView Wireless N Internet Camera

TV-IP110WN
Location: 200612131 16:00:31
Live View Basic » System
Basc

Camera Name:
Smart Wizard LeTai™

Indication LED

Basic
Indication LED control: @ Normal () OFF

« System

“Doto s Time e

* User

Network
Video

Event Server
Motion Detect
Event Config
Tools

Device Info

Copyright © 2011 TRENDnet. Al Rights Reserved.
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The following screen will pop up.

@ TRE"DnET SecurView Wireless N Internet Camera

TV-IPT10WN

Location:  2006/12/31 16:00:55

Welcome to the Smart Wizard.
This wizard will help you quickly set up the
Network Camera to run on your network

Camera Settings

Camera Name:

Camera Seftings )
Location:

Camera Name: Enter a descriptive name e PO,
forthe camera. For example, camera 1

Confirm Password:

Location: Enter a descriptive name for the

location used by the camera. For example, | Wext> || Cancel |

meeting room 1

Admin Password/Confirm Password
Enter the administrator password twice to
set and confirm the password to ac

the camer. iguration Utilty

Copyright © 2011 TRENDnet. All Rights Reserved.

Step 1. Camera Settings

Camera Settings

Enter Camera name,
Location, New Admin
Location: password and enter
again to confirm

Camera Name:

Admin Password: Admin password

Confirm Password:
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Step 2. IP Settings

IP Settings

© DHCP

Select the IP setting
according to your
1P ! network: DHCP,
Static IP, or PPPoE.

Static IP

Subnet Mask:

Default Gateway:

Primary DNS:

Secondary DNS:
PPPoE

User Name:

Password:

Step 3. Email Settings

Email Setting

SMTP Server Address:

Enter the required
Port Number: information to be

able to send email
Sender Email Address: with image.

Authentication Mode: @ Mone SMTP

Sender User Name:

Sender Password:

Receiver #1 Email
Address:

Receiver #2 Email
Address:
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Step 4. Wireless Networking

Wireless Networking

Network ID(S SID): TREMNDnet Site Sunvey

Wireless Mode: @ Infrastructure Ad-Hoc

Channel: 5 - Click Site Survey to
select the SSID and
then complete the
required settings.

Authentication: Open

Encryption: @ MNone () WEP

Format: ASCI HEX

Key Length: G4 bits 128 bits

WEP Key 1

WEP Key 2

WEP Key 3

WEP Key 4
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Step 5. Confirm Settings

Camera Hame:

This step shows all

Location: the setting
information.

IP Mode: DHCP

IP Address: 152.168.10.30

Subnet Mask:

Default Gateway:

192 168.10.1

Primary DN 5:

Secondary DN 5:

SMTP Server Address:

Port Humber:

[X]
o

Sender Email Address:

Authentication Mode:

Sender User Name:

Receiver #1 Email
Address:

Receiver #2 Email
Address:

ESSID:

TRENDnet

Connection:

Infrastructure

Channel:

[

Authentication:

Encryption:

WRAZ-FSK

AES

This step shows the configuration of your camera. When you confirm the

settings, click Apply to finish the wizard and reboot the camera. Click Prev

to go back to the previous step(s) and change the settings; or click Cancel
to end the wizard and discard the changes.
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4.3 Basic Setup

The Basic menu contains three sub-menus that provide the system settings
for the camera, such as the Camera Name, Location, Date & Time, and
User management.

@ TRE"D“ET SecurView Wireless N Internet Camera

TV-IP110WN

Location: 2006/

Basic » System
:

Smart Wizard
Indication LED

Basic Indication LED control: @ Normal I7) OFF

» System
- Date & Time |

- User

Network
Video

Event Server
Motion Detect
Event Config
Tools

Device'Info

Copyright © 2011 TRENOnet. All Rights Reserved
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Basic >> System

Basic » System

Basic

Camera Name:
Locati

Indication LED

Indication LED control: @ Mormal ) OFF

B Basic
- Camera Name: Enter a descriptive name for the camera.
- Location: Enter a descriptive name for the location used by the
camera.
B Indication LED
This item allows you to set the LED illumination as desired. There are
two options: Normal and OFF.

Basic >> Date & Time

Basic » Date & Time

Date and Time

TimeZone: {GMT-08:00) Pacific Time[US & Canads); Tijusna -

Setting: “I Synchronize with PC
@ Synchronize with NTF Server
NTP Server Address:
Updste Interval: 8 ¥ hours

~) Manual

Date: 20061231 [yyYY/MMDD)

Time: 18:16:02 {hh:mm:ss)
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B Date & Time

- TimeZone: Select the proper time zone for the region from the pull-
down menu.

- Synchronize with PC: Select this option and the date & time settings
of the camera will be synchronized with the connected computer.

- Synchronize with NTP Server: Select this option and the time will be
synchronized with the NTP Server. You need to enter the IP address
of the server and select the update interval in the following two
boxes.

- Manual: Select this option to set the date and time manually.

Basic >> User

Basic » User

User Accounts

Administrator: Password:

Confirm Password: Modify
General User: User Name:

Password: Add/Modify

UserList: hd Delete
Guest: User Name:

Password: Add/Modify

UserList: - Delete
Direct Video Stream a1

i Appl

Authentication: Enstle Iﬂl

B Administrator

To prevent unauthorized access to the camera’s Web Configuration,
you are strongly recommend to change the default administrator
password. Type the administrator password twice to set and confirm
the password.

-28 -



B General User

- User Name: Enter the user’s name you want to add to use the
camera.

- Password: Enter the password for the new user.

When you are finished, click Add/Modify to add the new user to the
camera. To modify the user’s information, select the one you want
to modify from User List and click Add/Modify.

- User List: Display the existing users of the camera. To delete a user,
select the one you want to delete and click Delete.

B Guest

- User Name: Enter the guest’s name you want to add to use the
camera.

- Password: Enter the password for the new guest.

- User List: Display the existing guests of the camera. To delete a user,
select the one you want to delete and click Delete.

NOTE: The “General User” can access the camera and control the
Function buttons of the camera’s Web Configuration; the “Guest’ can only
view the live view image from the main page of the Web Configuration
while accessing the camera. Only the “Administrator” is allowed to
configure the camera through the Web Configuration.

B Direct Video Stream Authentication:
- Enabled = Direct link to the video stream prompts for authentication.
- Disable = Direct link to video does not prompt for authentication for
ease of use when implementing or embedding the video stream into a
custom application or webpage.

Examples of the Direct Link to video:
MIJPEG Mode
http://camera_ip address:port number/jpgview.htm
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http://camera_ip_address:port%20number/jpgview.htm

4.4 Network Settings

The Network menu contains three sub-menus that provide the network
settings for the camera, such as the IP Setting, DDNS Setting, IP Filter, and
wireless network.

© DHCP
Static IP
IP:
Subnet Mask:
Default Gateway.
Primary DNS:
Secondary DNS:

ireless
_— PPPOE

Video/Audio Use Nats
P
Event Server Password:

P—— X
Motion Detect 2 [7] Enable

ETE——— Provider. www.dyndns.com
Event Config
Host Name:

_—
Tools User Name:

a Password
Device Info wer

[T] Enable

HTTP Port (default: 80)

Enable

HTTPS Port (default: 443)

[ e
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Network >> Network

IP Settings: @ DHCP
StaticIP
IP:
Subnet Mask:
Default Gateway
Primary DNS:
Secondary DNS:
PPPOE
User Name:
Password:
DDNS Setting: 7] Enable
Provider. wnw.dyndns.com =
Host Name
User Name:
Password
UPnP: | Enable
Ports Number: HTTP Port 80 (default 80)
HTTPS: Il Enable
HTTPS Port 443 (default: 443)

B |P Setting

This item allows you to select the IP address mode and set up the
related configuration.

- DHCP: The default IP Setting mode was set as DHCP. Select this
option when your network uses the DHCP server. When the camera
starts up, it will be assigned an IP address from the DHCP server
automatically.

- Static IP: Select this option to assign the IP address for the camera
directly. You can use IPSetup to obtain the related setting values.
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P By the default setting, your camera IP address is
assigned from your DHCP server. If you do not
have a DHCP server in your network, the IP
address will be assigned to 192.168.10.30.

Subnet Mask Enter the Subnet Mask of the camera. The
default setting is 255.255.255.0.

Default Gateway Enter the Default Gateway of the camera.

Primary/ DNS (Domain Name System) translates domain

Secondary DNS names into IP addresses. Enter the Primary DNS

and Secondary DNS that are provided by ISP.

- PPPoOE: Select this option when you use a direct connection via the
ADSL modem. You should have a PPPoE account from your Internet
service provider. Enter the User Name and Password. The camera
will get an IP address from the ISP as starting up.

NOTE : Once the camera get an IP address from the ISP as starting up, it
automatically sends a notification email to you. Therefore, when
you select PPPoE as your connecting type, you have to set up the
email or DDNS configuration in advance.

B DDNS Setting
With the Dynamic DNS feature, you can assign a fixed host and
domain name to a dynamic Internet IP address. Please refer to
Chapter 6 for detail instruction.

B UPnP
The camera supports UPnP (Universal Plug and Play), which is a set of
computer network protocols that enable the device-to-device
interoperability. In addition, it supports port auto mapping function so
that you can access the camera if it is behind an NAT router or firewall.
Select the Enable option to enable this feature.

B Ports Number
- HTTP Port: The default HTTP port is 80.
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NOTE: If the camera is behind an NAT router of firewall, the port number
is suggested in the range between 1024 to 65535.
B HTTPS

- Enable: Select this option to enable HTTPS, which is a secure
protocol to provide authenticated and encrypted communication
within your network.

- HTTPS Port: Assign a HTTPS port in the text box. The default
HTTPS port is 443.

Network >> IP Filter

Network » IP Filter

1P Filter

IP Address Range:

Deny IP List

The IP Filter setting allows the administrator of the camera to limit the
users within a certain range of IP addresses to access the camera.

B Start/End IP Address

Assign a range of IP addresses that are not allowed to access the
camera by entering the Start IP address and End IP address. When you
are finished, click Add to save the range setting. You can repeat the
action to assign multiple ranges for the camera.

For example, when you enter 192.168.10.50 in Start IP Address and
192.168.10.80 in End IP Address, the user whose IP address located
within 192.168.10.50 ~ 192.168.10.80 will not be allowed to access
the camera.
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H  Deny IP List

The list displays the range setting(s) of IP addresses that are not
allowed to access the camera. To clear the setting, select a range of IP
addresses from the list and click Delete.

Network >> Wireless Setting

Network » Wireless Setting

Wireless

Enable td

MNetwork I0{5 510} TRENDnet Site Survey

Wireless Mode: @' |nfrastructure Ad-Hoo

Channel:

Authentication:

Encryption:

Format: ASCI HEX

Key Length: B4 bits 128 bits

WEP Key 1:

WEP Key 2:

WEP Key 3:

WEP Key 4:

B Wireless

The camera supports WLAN while you use the wireless network. Select
the Enable option to enable this feature.

- Network ID (SSID}: The default SSID setting is “TRENDnet”. To
connect the camera to a specified wireless network, set a SSID for
the camera to correspond with the wireless network’s SSID (ESS-ID).
You can do so by clicking the Site Survey to display the available
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wireless networks, so that you can easily connect to one of the
listed wireless networks.

Wireless Networking

Network ID{SSID): TRENDnet310 Site Survey

ESSID MAC Channel Mode Privacy Signal
[TRENDnet 00:08:54:00:00:00 ik Infrastructure No 26%
W1SO0NR 00:0d:56:01:01: 01 1 Infrastructure Yes 23%
Trendnet2 00:14:01 00:00: 01 2 Infrastructure Tes 13%

Wireless Mode: @) Infrastructure Ad-Hoc

Channel: G -

Authentication: WPAZ-PSK -

- Wireless Mode: Select the type of wireless communication for the
camera: Infrastructure or Ad-Hoc.

- Channel: Select the appropriate channel from the list.

- Authentication: Select the authentication method to secure the
camera from being used by unauthorized user: Open, Shared-key,
WPA-PSK, and WPA2-PSK. The following table explains the four

options:

Open The default setting of Authentication mode, which
communicates the key across the network.

Shared-key Allow communication only with other devices with
identical WEP settings.

WPA-PSK/ WPA-PSK/WPA2-PSK is specially designed for the

WPA2-PSK users who do not have access to network

authentication servers. The user has to manually
enter the starting password in their access point or
gateway, as well as in each PC on the wireless
network.

-35-




If you select Open or Shared-key as the Authentication mode, you
need to complete the following settings:

Encryption: Select the WEP option to enable the data encryption
feature to secure the camera within the wireless network.

Format: Once you enable the Encryption feature, you need to
determine the encryption format by selecting ASCII or HEX. ASCII
format causes each character you type to be interpreted as an eight-
bit value. Hex format causes each pair of characters you type to be
interpreted as an eight-bit value in hexadecimal (base 16) notation.

Key Length: Select the WEP key length you use: 64 bits or 128 bits.
WEP Key 1/2/3/4: Enter the WEP key(s) in the following boxes.

If you select WPA-PSK or WPA2-PSK as the Authentication mode, you
need to complete the following settings:

Encryption: Select TKIP or AES. TKIP (Temporal Key Integrity Protocol)
changes the temporal key every 10,000 packets to insure much
greater security than the standard WEP security. AES (Advanced
Encryption Standard) is used to ensure the highest degree of security
and authenticity for digital information.

Pre-Shared Key: This is used to identify each other in the network.
Enter the name in the box, and this name must match the Pre-shared
key value in the remote device.
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Network >> Wireless >> WPS Setting

WQPS (Wi-Fi Protected Setup) sets a new standard of Wi-Fi security,
providing a simplified secure network setup solution for the end users.
Once the required settings have been completed, your wireless network
can be protected by simply pressing the WPS button on the camera.

@ TRE"DnET SecurView Wireless N Internet Camera

[
Smart Wizard
Basic

Network

« Network

*1P Filter

* Wireless
- WPS

e —
Video/Audio

[ —
Event Server

e —
Motion Detect

P
Event Config

P
Tools

[ ——
Device Info

B WPS

TV-P110WN
Location:  2011/01/01 00:02:35
Network » Wireless » WPS Setting

wpPs

® PIN Mode

PIN Code: 06307363

PBC Mode:

= .

Device Status

Copyright © 2011 TRENDnet. All Rights Reserved.

- PIN Mode: The PIN (Personal Information Number) mode builds the
connection by entering the PIN Code directly. Once you enter the
PIN Code of the camera in the router (or access point) that supports
WPS, you can directly build a WPS connection between the camera.

- PBC Mode: The PBC (Push Button Configuration) mode builds the
connection by scanning the devices in the wireless network. Once
you press the camera’s WPS button, it starts to scan the WPS
devices in the wireless network, and then you can build the WPS
connection by clicking the Connect button.
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B Device Status
Display the WPS configuration of the camera.

TIP The Power LED indicates the WPS connection status by:
- Blinking 3 times when the connection is built successfully.

- Repeating 3 times of short-short-long blink when the
connection is failed.
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4.5 Setting up Video & Audio

The Video contains three sub-menus that provide the video or audio
settings for the camera.

@ TRE“DHET SecurView Wireless N Internet Camera

TV-P110WN

Location: 2011/01/01 00:07:06

Video & Audio » Camera

Smart Wizard

Network

Video/Audio

+Camera
* Video
Zhndio; Image Setting

Event Server Brightness: 45 (0~100)

Motion Detect S 55 (0~100)

Saturation: 35 (0~100) | Default |

Event Config

Mirror: [T Vertical [] Horizontal

Tools Light Frequency: 9 50Hz © 60Hz @ Outdoor

Device Info |~ Apply " Cancel |

Copyright © 2011 TRENDnet. All Rights Reserved.
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Video & Audio >> Camera

Image Setting

Brightness: 45 (0~100)

Contrast: 55 (0~100)

Saturation: 35 (0~100) Default

Mirror: [7] vertical [[] Horizontal

Light Frequency: 50Hz ) 60Hz @ Outdoor

[ pe—

B Image Setting

Brightness: Adjust the brightness level from 0 ~ 100.
Contrast: Adjust the contrast level from 0 ~ 100.
Saturation: Adjust the colors level from 0 ~ 100.

Click Default to restore the default settings of the three options
above.

Mirror: Select the Horizontal option to mirror the image
horizontally. Select the Vertical option to mirror the image vertically.

Light Frequency: Select the proper frequency according to the
camera’s location: 50Hz, 60Hz, or Outdoor.
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Video & Audio >> Video

Video » Video

Video Resolution: VGA -

Highest w»

B MIJPEG

- Video Resolution: Select the desired video resolution from the
three formats: VGA, QVGA and QQVGA. The higher setting (VGA)
obtains better video quality while it uses more resource within your
network.

- Video Quality: Select the desired image quality from five levels:
Lowest, Low, Medium, High, and Highest.

- Frame Rate: Select a proper setting depending on your network
status.

NOTE : The camera supports MJPEG compression. MJPEG capture the
images in JPEG format, which require higher bandwidth to view
smooth video. The administrator can control the bandwidth of
each connection well through the setting options above.

Video & Audio >> Audio

Video & Audio » Audio

Camera Microphone In

B Camera Microphone In

Select the Enable option to enable the camera’s audio function, so
that you can receive the on-site sound and voice from the camera.
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4.6 Event Server Configuration

The Event Server menu contains three sub-menus that allow you to send
notification to NVR, upload images to FTP or send images to email
accounts.

@ TRE“D“ET SecurView Wireless N Internet Camera
TV-IP1T10WN

Location:  2011/01/01 15:39:09

Event Server Setting » HTTP
HTTP Notify For Motion Trigger

Smart Wizard

Basic

Network 3 fegi/event.cgi?status=#s &time=#t&mo

Video

Event'Server

« HTTP

<FTP

* Email

Motion Detect
Event Config

Tools

Device Info
Copyright © 2011 TRENDnet. All Rights Reserved.

When you complete either of the required settings of HTTP, FTP or Email,
click Test to verify the configuration. Once the camera connects to the

server successfully, click Apply.
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Event Server Setting>> HTTP

Event Server Setting » HTTP

HTTP Notify For Motion Trigger

icgievent.cgi?status=#satime=#t&m

B HTTP Notify For Motion Trigger
Send the query parameter via an HTTP notification when an event is
triggered.
- Host: Enter the IP of the HTTP server
- Port: Enter the Port number of the HTTP server
User Name: Enter the username of the HTTP server
Password: Enter the password of the HTTP server
Query: Enter the query parameter for the request if necessary

Example:
Host: 192.168.10.1
Port: 80
Query: xxx.cgi?namel=valuel&name2=value2
Ex: cgi/event.cgi?status=#s&time=H#t&model=modelname
Result:
http://192.168.10.1:80/cgi/event.cgi?status=#s&time=#t&model=m

odelname
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Event Server Setting>> FTP

Event Server Setting » FTP

FTP

Host Address:

Port Number: 21

User Name:

Password:

Directory Path:

Passive Mode: | Enable

H  FTP
- Host Address: Enter the IP address of the target FTP server.

Port Number: Enter the port number used for the FTP server.

User Name: Enter the user name to login into the FTP server.

Password: Enter the password to login into the FTP server.

Directory Path: Enter the destination folder for uploading the
images. For example, /Test.

Passive Mode: Select the Enable option to enable passive mode.
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Event Server Setting >> Email

SMTP Server Address:

Sender Email Address:

SMTP Port: 25

This server requires an
encrypted connection
(SSL):

STARTTLS:

Authentication Mode: © None © SMTP

Sender User Name:

Sender Password:

Receiver #1 Email
Address:

Receiver #2 Email
Address:

Wan IP Change Notify: [

—T T

B Email

SMTP Server Address: Enter the mail server address. For example,
mymail.com.

Sender Email Address: Enter the email address of the user who will
send the email. For example, John@mymail.com.

SMTP port: Enter the SMTP port used for the email about

SSL/STARTTLS: Most free email services require an encrypted
connection. If you are using a free email service, please check the
mail server requirement and select the options that apply to the
server.

Authentication Mode: None or SMTP, for SMTP account, please
select SMTP option.

Sender User Name: Enter the user name to login the mail server.
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- Sender Password: Enter the password to login the mail server.

- Receiver #1 Email Address: Enter the first email address of the user
who will receive the email.

- Receiver #2 Email Address: Enter the second email address of the
user who will receive the email.

- WAN IP Change Notification: Select the option to enable the system
to notify you when the WAN IP address changed.

4.7 Motion Detect

The Motion Detect menu contains the command and option that allow you
to enable and set up the motion detection feature of the camera. The
camera provides two detecting areas.

@ TRENDNET A N i s

TV-P110WN
Location:  2011/01/01 14:51:57

[ Uve View | Motion Detection » Detection Configuration

£90 Setup

Smart Wizard
Basic
Network

Video

————— T
0 g

. — b g i
T o Py My

Tools

VBT — q]!,/il';wlu'//

i

MU%J

Copyright © 2017 TRENDnet. Al Rights Reserved
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To enable the detecting area, select Window 1 or 2 from the pull-down list,
and then select Enable. When the detecting area is enabled, you can use
the mouse to move the detecting area and change the area coverage.

Motion Detection » Detection Configuration

— Motion Detect

Window [2 ¥

[V Enable

S e—

J_

Threshold

Sensttivity

Save Cancel

- Name: Assign a name to the detecting area.

- Threshold: Move the slide bar to adjust the level for detecting
motion to record video. Click Save once done the
setting.
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4.8 Event Config

The Event Config menu contains four sub-menus that provide the
commands to configure event profiles.

@ TRE“D"ET SecurView Wireless N Internet Camera

Smart Wizard
Basic

Network

Event'Server
Motion Detect

Event Config

- General
+ Schedule Profile

+ MotionDetect Trigger
+ Schedule Trigger

Tools

Device'Info

TVIP110WN
Location:  2011/01/01 14:55:29
Event Configuration » General Setting
General

Filename Prefix:
Snapshot Filename Prefix

Copyright © 2011 TRENDnet. All Rights Reserved.
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Event Configuration >> General Setting

Event Configuration » General Setting

General

Filename Prefix:
Snapshot Filename Prefix

- Snapshot/Recording Filename Prefix: You can assign a given prefix

to each new captured file. Otherwise, leave this option blank to use
the default setting.

Event Configuration >> Arrange Schedule Profile

Event Configuration » Arrange Schedule Profile

Schedule Profile

This sub-menu displays the scheduled profile(s). To customize the profile,

click Add and then enter a descriptive name for the profile in the prompt
dialog window.

Explorer User Prompt - —— _— > S|
Script Prompt
Please enter a profile name

Cancel
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After entering the profile name, click OK and the profile is added to the
Schedule Profiles list. Click the profile name again to display the schedule
profile page. To delete the profile, select the profile in the list and click
Delete.

Event Configuration » Arrange Schedule Profile

Schedule Profile

Mon Tue Wed Thu Fri Sat

| Add H Copy this to all weekdays ‘

| Delete | ‘ Delete this from all weekdays ‘

- Profile Name: Display the profile name that you select in the
Schedule Profiles list.

- Weekdays: Select the weekday(s) that you want to separately assign
in the schedule profile. The weekday that has been assigned will be
displayed with green color.

- Time List: Display the time period that you have assigned within the
selected weekday. To assign the same time period to every weekday,
click Add this to all weekdays; click Delete this from all weekdays
to remove the selected time period from every weekday. Click
Delete to remove the selected time period.

- Start/End Time: Enter the start and end time and then click Add to
assign a time period within in the selected weekday.
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Event Configuration >> Motion Detect Trigger

Event Configuration » Motion Detect Trigger

Motion Detect Trigger
(*Please set the corresponding server setting first)

Enable O

Schedule Profile: always v

[C] HTTP Motify
[C] send Email
["] FTP Upload

Select the Enable option to enable the trigger function of the camera, so
that you can send captured images within the detecting area to the FTP
server and email receiver. You have to configure corresponding settings,
such as FTP server and email server, to enable this feature.

- Schedule Profile: Select a schedule profile from the pull-down list.

- Action: Select the destination that the captured images will be sent to:
HTTP Notify, Send Email, or FTP Upload.
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Event Configuration >> Schedule Trigger

Event Configuration » Schedule Trigger

Email Schedule

Enable O

Schedule Profile: always ¥

Interval: 20 sec(s)
FTP Schedule

Enable O

Schedule Profile: always -

Interval: @ 30 sec(s)frame

1 +|frame(s)¥sec

You can separately configure the schedule for trigger function of the
camera by Email or FTP. Select the Enable option on each item, and then
select a Schedule Profile from the pull-down list and set the Interval time.
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4.9 Tools

The Tools menu provides the commands that allow you to restart or reset
the camera. You can also backup and restore your configuration, and
upgrade the firmware for the camera.

@ TREnDnET SecurView Wireless N Internet Camera

TV-PT10WN
Location:  2011/01/01 15:02:15

System Tools » Tools

Factory Reset
Factory reset will restore the devios's factory default ssttings.

Smart Wizard

P
i System Reboot

R
Network Reboot the device.

Video

——
Event Server Configuration

TTTETTEETE——— Backup the device configurations. Click the button bellow and save the device configurations to your lacal harddrive
Motion Detect
Get the backup file

Restors your device's configuration from a backup file.

e —
Event Config

—
Device Info

Update Firmware

Current Firmware Version: 1.1.0 build:17

Sslect the firmware:

Copyright © 2011 TRENDnet. All Rights Reserved.
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B Factory Reset

Click Reset to restore all factory default settings for the camera.

B System Reboot

Click Reboot to restart the camera just like turning the device off and
on. The camera configuration will be retained after rebooting.

B Configuration

You can save your camera configuration as a backup file on your
computer. Whenever you want to resume the original settings, you
can restore them by retrieving the backup file.

- Backup: Click Get the backup file to save the current configuration
of the camera.

- Restore: Click Browse to locate the backup file and then click
Restore.

B Update Firmware

This item displays the current firmware version. You can upgrade the
firmware for your camera once you obtained a latest version of
firmware.

- Select the firmware: Click Browse to locate the backup file (xxx.pck)
and then click Update. Factory reset and IP Setup are required after
firmware update.

NOTE: Make sure to keep the camera connected to the power source
during the process of upgrading firmware. Otherwise, the camera
might be damaged because of failure of upgrading firmware.
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4.10

Information

The Information menu displays the current configuration and events log of

the camera.

Smart Wizard

Network
Video/Audio
Event'Server
Motion Detect

Event Config

Jevice'Info

* Device Info
« System Log

System Information » Device Information

Basic

Camera Name:

TV-IP110WN

Location:

Firmware Version:
Video & Audio

MJPEG Resolutiol

1.2.0 build: 39

VGA

Microphone
Network

IP Mode:

Enable

Static

IPv4 Address:

192.168.1.141

IPv4 Subnet Mask:

255.255.255.0

1Pv4 Gateway:

192.168.1.254

Primary DNS Address:

Secondary DNS address:

MAC Address:

00:FF:22:00:33:0D

UPnP Enable:

Disable

TrendnetSkyN

Infrastructure

9

Authentication:

WPA2-PSK

Encryption:

AES

Copyright © 2011 TRENDnet. All Rights Reserved.

H Device Info

Display the Basic, Video, Network, and Wireless settings of the camera.

B System Log
The Logs table displays the events log recorded by the system.
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CHAPTER 5

SECURVIEW™ PRO SOFTWARE

This chapter describes detailed instructions on using SecurView Pro, a
customized software application with a user-friendly interface that allows
you to access your cameras. The Software can monitor and record up to 36
cameras. It also let you change some basic settings of the camera, such as
schedule profiles and motion detecting areas. The SecurView Pro also
supports audio or Pan/Tilt function.

It is recommended to use a high performance computer if you want to
connect multiple cameras simultaneously.

® Platform: Microsoft® Windows® 7/Vista/XP
Hard Disk: 80GB or above

Resolution: 1024x768 or above

Hardware Requirement

1~ 8 cameras: Intel Core 2 Duo; 2GB RAM
9 ~ 32 cameras: Intel Core 2 Quad; 4GB RAM

* For Windows Vista users: please go to User Accounts and Family Safety
> User Accounts > Turn User Account Control on or off, then uncheck
the checkbox of “Use User Account Control (UAC) to help protect your
computer”. Restart your computer to validate the setting. For additional
information of User Account Control, please go to
http://www.microsoft.com/windows/products/windowsvista/features/details/u
seraccountcontrol.mspx

* For Windows 7 users, please go to Control Panel > User Accounts >
Change User Account Control Setting to lower your notify setting. For
additional information of User Account Control, please go to
http://windows.microsoft.com/en-us/windows7/products/features/user-
account-control

-56-


http://www.microsoft.com/windows/products/windowsvista/features/details/useraccountcontrol.mspx
http://www.microsoft.com/windows/products/windowsvista/features/details/useraccountcontrol.mspx
http://windows.microsoft.com/en-us/windows7/products/features/user-account-control
http://windows.microsoft.com/en-us/windows7/products/features/user-account-control

5.1 Installation

1. Insert the Installation CD-ROM into your computer’s CD-ROM
drive to initiate the Auto-Run program.

2. Click the SecurView Pro from the Auto-Run menu screen.

@ TRenDneT

1P Setup

SecurView Pro

User's Guide

Product Registration

=
SecurView Wireless N
Internet Camera
TV-4P110WN

& Copyright 2011 TRENDnet. All Rights Reserved.

NOTE: To use SecurView Pro, you must have Microsoft .NET Framework
2.0 installed in the computer. The setup wizard will detect it and,
if the program is not installed yet, it will ask you to install it during

the process of installing SecurView™ Pro.

NOTE: Microsoft Windows Installer 3.0 or above is a required component
to install SecurView Pro. For more information of the required
component during installation, please visit the Microsoft support

Website.
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3. Then SecurView Pro Setup Wizard will appear. Click “Install”.
'@’ Setup - SecurView Pro &l_‘ﬂ‘

Ready to Install
Setup is now ready to begin installing SecurView Pro on your computer.

Click Install to continue with the installation.

4. Wait until the program finish the installation. By default, the
destination location is C:\Program Files\TRENDnet\SecurView Pro.

¢ 5
£2 Setup - SecurView Pro ==

Installing
Please wait while Setup installs SecurView Pro on your computer.

Extracting files...
C:\Program Files\TRENDnet\SecurView Pro\Skin\Resolution2\N_Button_r2_c2.jpgq

Cancel
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5. Click “Finish” to finish the installation.

& Setup - SecurView Pro =

Completing the SecurView Pro '
Setup Wizard

Setup has finished installing SecurView Pro on your
computer. The application may be launched by selecting the
installed icons.

Click Finish to exit Setup.

6. Afterinstalling the SecurView Pro, the application is
automatically installed to your computer, and creates a folder in
“ Start \Program\TRENDnet\SecurView Pro” .

TRENDnet
IPSetup
SecurView Pro
& SecurView Pro
f& Streaming Server
F& Uninstall SecurView Pro -

1 Back

2|

I
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5.2 Using SecurView™ Pro

5.2.1 Launch the Program

To start SecurView Pro, click Start > All Programs > TRENDnet >SecurView
Pro > SecurView Pro. You can also start the program by double-click the
SecurView Pro icon on your desktop.

P

SecurView Pro

@™ TRENDNET

Please enter user name and password

User name: EGlii

Password:

SecurView

ight 2010 TRENDnet. All Rig

On the login window, enter the User name/Password and click OK to login.
The default User name/Password is admin/admin. If you wish to save the
login information, please select Auto Login.
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5.2.2 Main Window and Features

When you start and login to SecurView Pro, the Main window will display
as below:

g.._...“,” — —

SecurView

) | o

eMap

Camera List
CH# Name 6

N (D (0 UOEE
D) ooowel | K
N 9 =

The Main window provides you with the information on operating the

system, as well as the control panel such as the Quick Launch buttons, and
so on.

NOTE For best result, it is higher recommended to configure resolution setting to

1024 x 768 or higher; otherwise, it cannot be displayed on the screen
when launching the program.

0 Live View Window displays the live video of the connected camera(s).
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9 Quick Launch Buttons are located below the Live View Window,
providing you with the following quick-launch functions:

Button Function

(D Logout : To log out the SecurView Pro program
Close: To close the SecurView Pro program

Restore Recording Type: Restore all recording type to current
camera’s setting

All Continuous Recording: Continuous recording on all
cameras

@

Stop All Recording: Stop recording on all cameras

View Setting: To configure eMap settings
eMap View: To view current maps
Camera Status: Display cameras status

Playback: Playback recorded files

Schedule: Display Schedule Configuration window

Event Server: Setup a SMTP server

Address Book: Add/Remove email address for event
notification

@ @Q @

Event Trigger: Setup event trigger configuration

Device Setting : Set up the camera

€

Recording Setting: Set up the recording path

Account information: Setup administrator password

@&

Version: Display software version
System Setting: Software settings
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9 Camera View Mode buttons in this area allow you to switch the
camera view mode.

Buttons | Functions

Display the connected camera(s) in a single camera view
mode.

Display the connected camera(s) in a quad view mode.

Display the connected camera(s) in a 3 x 3 grid view mode.

Display the connected camera(s) in a 13-camera view mode
using a split window. The first camera is displayed as the
major view.

E BOO

Display the connected camera(s) in a 17-camera view mode
using a split window. The first camera is displayed as the
major view.

Display the connected camera(s) in a N x N grid view mode,
supporting up to 36 cameras.

Display the live view of the selected camera in full screen
mode. Click ESC on the keyboard to return to Main window.

EEl &

Automatically switch the live view of each connected
cameras in single camera view mode by 30 seconds*. Click
once to start and click again to stop.

Bl

* The auto-switch time is set as 30 seconds by default, which

can be changed by clicking the @ -> System Setting and
then change the value from the pull-down list of the Auto
Switch time interval option.

@ System Information displays the system information, including the
date and time, and the available storage space of the system.

6 Live View Status provides the status of live view mode, including
Camera List and eMap.
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B Camera List displays the status of the connected cameras. If
multiple cameras are connected, you can switch to the live
view of each camera by simply selecting the camera from the

list.

B eMap allows you to select the desired camera to the view
from the map easily. Please note that you have to set up the
eMap for monitoring in advance.

@ Camera Control Buttons provides the control buttons that allow you
to control the selected camera.

Buttons

Functions

@

Talk On/Off. Click to enable/disable the speaker function
of the connected camera. This option is available only in
single camera view mode.

Listen On/Off. Click to enable/disable the microphone
function of the connected camera. This option is available
only in single camera view mode.

)

For Pan/Tilt cameras, use this control panel to set the
preset positions (up to 8 positions).

Use Navigation buttons to adjust camera position, and
then select the position number (1~8) from the Set
button.

To move to the preset position, simply select the position
number (1~8) from the Go button.

Navigation Buttons (Left/Right/Up/Down/Home). If the
connected camera has pan/tilt functions, the Navigation
buttons allow you to move the camera lens position.
Clicking the Home (center) button will move the camera
lens to the assigned home position.

(] / (oo

The Patrol/Stop buttons are used to enable/disable the
patrol function of the camera. Click Patrol to start
patrolling through the preset positions once. Click Stop to
stop patrolling.
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5.2.3 Manage the Cameras

Before adding the cameras, please setup the recording setting first.

B Configure Recording Settings

1. Click the button and then select Record Setting.

2. Default path is C:\, click Browse and select the desire
directory then click Save to complete the configuration.

To change the time interval for recording, select time from

the pull-down menu.

5 Record Setting

e

F—wme > Record Setling
Basic

Recording Path: |C

i Record File: (60| Seconds

| Browse

Free space : 256 GB
9| Recycle Mode

* Please choose the recording target fokder.

For example:
If the Recording Path is D-Wideo
The network camera'’s recording files will be saved to D:\Video\Video Data\CH1

The network camera'’s recording files will be saved to D:\Video\Video Data\CH32

Save Cancel
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Add a Camera

1. Click the @) button and select Device Setting to display the
Device Setting window.

2. Click New.
5/, Device Set X
Device > Device Setting
Device List |
Camera Title  IP address Pot CH#  Brand Model Record Type Stream

N

New Modify Remove
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Click on Search, all cameras that’s connected to your network
would appear.

o P
Device > New Camera

Setting

New Canj—
Device Search

hodat IP address Port  Device Name MAC Address

Camera T
IP addreg)
Port

Account

Password

Stream

Record:

.
m\ [ose |

Save Cancel Back to List

Select the camera you would like to add and then click Add.

r N

Device Search

IP address Port Device Name MAC Address Z
192 168.1.77 80 TV-IP110WN noinaToAnon

m

[ Add ] ISearchl I Close ]
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5.

The information of the camera will display on the screen.

It will auto detect the IP address/port number and display the
stream type of the camera. Please type in the correct account
name and password, then select Preview to view live image.

Device
Device > Modify Camera TV-IP110WN
Setting
I Modify Camera | Device Search Mation detection area |
Model [Tvapriown ~
CameraTile:  TVAP110WN Preview Window
IP address: 192168177
Port 80
Account admin
Password: """
Streem: MPEG4@ MJPEG | H 264
Record: @ No Yes
[ sawe | [ Cancel | [Backtolist |

=)

e

If you would like to use motion detection function, you can
setup the Motion detection area by click Motion detection

area button.

Device
Device > Modify Camera TV-IP110WN

Setting

w Modify Camera | Device Search Motion detection area |

Model TVIP11OWN v

Preview Window

Camera Title: TVIP110WN
IP address. 192 152 1 77 [
Port 80
Account admin
Password s
Stream MPEG4® MJPEG ' H.264
Record No © Yes
Continuously Add Schedule
Schodulo & S
® Motion
Motion by Sched| |
Save Cancel Back to List

[ ASEOMOEE

. NS

-68 -



Enable motion detection windows, set up the senstivity and
click on Save.

[Back |

To setup recording style, select Yes on Record option. These
four recording types will appear. Select one of the recording
type, configure it then click Save.

Record: © No
© Continuously Add Schedule
© Motion
© Motion by Schedule S
© Digital Input
Save ’ [ Cancel ] l Back to List ]
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Continuously:
Record the stream video continuously

Schedule:
Records stream video by schedule. You can setup the
schedule by click Add Schedule here.

Click on New to create a new schedule and select the time to
record. Click on Save when finish.

&= Schedule Configuration

Schedule > Schedule Configuration

Schedule

Schedule List

Schedule Title Sin Mon Tue Wed Thu Fri  Sat

Weekly Schedule

Schedule Title Work Time Select All Delete Al

1112 13 14 15 16 17 18 19 20 21 22 23 24
[T1 [TTTT
11 11

Won L1 |
Tue [ 1] | EEE LI
Wed [ N N | |
Thu T T 1T | 1
Fri [T T T T T T T T T TTTTTTT [ TTTT 11
sat [TTTTTTTITTTTITTTITITITT [TTTT T
*One checkbox means recording for 30 minutes. ©[Ciick]  © siide -

Motion:
Record video by Motion Detection. Motion detection
recording required to setup a motion detection area.

To use motion detection record, please enable the detection
areas first. Click on Motion detection area to setup
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Motion by Schedule:

same requirement as Motion & Schedule recording.

Digital Input:

Recording triggered when there 1/0 port is triggered.

After all recording methods are configured, click Save to

apply the settings.
3
Device > New Camera
Setting
I New Camera Device Search | Motion detection area
Model TVAPTIOWN  ~
Camera Title: TVIP110WN Preview Window
IP address: 192.168.1.77
Port 80
Account: admin L
Password: """
Stream. MPEG4© MJPEG
Record No 9 Yes
© Continuously Add Schedule
Schoduis [ S [ Preview | Disconnect
Motion N N =
Motion by Sched -
s oy
= -
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8.

9.

Camera list will appear with recording type notification.

= hm‘-;_
Device > Device Sefting |
Device List
CameraTile  IPaddress  Pod  CHZ  Brand Model Record Type  Stream
1 TVPHOWN  192.168.1.77 80 1 TRENDnet TVAPT10WH Motion MIPEG
|
[ New | [ Modify | [Remove]

Once you added all the cameras, click the close button “x” on
the Device Setting windows to return to the main windows.
The cameras will display here.

Davice > Devico Seting
Devico List
CameTie IPadkess  Pon  CHe  Brand Model RecordType  Steam
TVPHONN 192168177 80 1 TRENDmet TVAPHOWN  NotRecoding  MUPEG |
TPI2W 1921681193 9112 2 TRENDMW! TVAIZIW  NolRecodng  MUPEG | | |
TVPSIOW 1921681167 9113 3 TRENDhl TVA4IOW  NoiRecodng  MUPEG
TVPHO 1921681213 9114 4 TRENDnet  TVAPHO  NotRecodng  MUPEG
TVP2E2P 1921681192 9115 5 TRENDnet  TVAP25P  NotRecoring  MPEGH
AV 4
SecurView
PRO
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NOTE Divx/Xvid codec is required for viewing the image of camera. If the image
cannot be displayed in the Live View/Preview window normally, click the
following path to download and install the required component:
http://download.divx.com/divx/DivXInstaller.exe
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B Edit / Delete a Camera

1. To edit a camera: From the Device Setting window, highlight
the camera you would like to edit then click on Modify button.

[ —— |

Device > Device Sefting |
Device List
Camera Title 1P address. Pot  CH# Brand Model Record Type Stream
TVIPHIOWN 192168177 80 1 TRENDnet TVIP11OWN  NotRecording  MJPEG
TVAP121W 1921681193 9112 2 TRENDnet  TVJP121W _ NotRecording  MJPEG
[TVIP410W 1921681187 9113 3 TRENDnet _ TV4P410W __ NotRecording _ MJPEG
TVAP110 1921661213 9114 4  TRENDnet  TVAP110 NotRecording  MJPEG
TVIP252P 1921681192 9115 5 TRENDnet ~TVAP252P  NotRecording  MPEG4

New | Modify | |Remove

2. To delete a camera: select the desired one and then click
Remove. Click Yes to confirm.

[ e ——

Device > Device Sefting

Device List
Camera Title 1P address. Pot  CH# Brand Model Record Type Stream
TVIPTIOWN 192168177 80 1 TRENDnet TVIP11OWN  NotRecording  MJPEG
TVAP121W 1921681193 9112 2 TRENDnet  TVIP121W Not Recording  MJPEG
[TVAP410W 1921681187 9113 3 TRENDnet  TVIP410W Not Recording MJPEG
VP10 1921681213 9114 4  TRENDnet  TVIP110 NotRecording  MJPEG
TVAP252P 1921681192 9115 5 TRENDnet  TVIP252P NotRecording ~ MPEG4

N

New | Modify | Remave
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B View Camera Image

Since you have added camera(s) to the system, the image of the
selected camera(s) will be displayed on the Live View Window
automatically. You can view a maximum of 36 cameras
simultaneously. Additionally, you can select one-camera or other
view mode to display the video from the Camera View Mode
buttons.

For example, if you use only one camera, select single camera

view mode ( D ), and the Live View Window will display the
view as below. You can select the other modes according to your
need.

The Information icon ( u ) on the top-right corner of the
window provides you with the options to connect/disconnect the
camera, select a camera to be displayed in the window, capture a
still image of the camera live video, or switch to eMap mode. Click
the Information icon to pop up the shortcut menu and select the
desired option.

Connect
Disconnect
Show Camera
Snapshot
eMap

! ikl
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B Playback the Recorded Files

1. Click the E button to display the Playback window.

SecurView
PRO

11/16/2010
13:43:50

2. On the Playback window, select the camera and setup the
begin/end date and begin/end time, then click Search. The
search result will be displayed in the Record File list.

e Playback E
Playback ; i
* Please download the MPEG4 codec, if it is not yet installed on your system. mioad codec
Single Channel
Search
Camera Begin Date: 11152010 ()= BeginTime: 15224pM 2
I 1TVIP110WN(192.168.1.77) ng Dale: 11462010 =  EndTme: 15224PM &
Search

Playback

C\Video DiatalCH11201 0\ 11151Gh1_2010.1"
C wlﬂaﬂ DaavﬁlﬂQmW“‘!S\Cm 20101

jeo DatalGH12010V11115\Ch1_2010.1
r Widso DiatalCHI 20101111 51Ch1_2010.1°
C Wideo DiatalCH1Z0101 11151Ch1_2010.1
C\WVideo DataiCH1I201 0 1115\Gh1_2010.1
. Viden NatalCHIDM S 1151Ch1 20104 =
‘ I »
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3. To playback the video clip, select the desired file and click
Play.

O ————————————— ™

Fypack * Please download the MPEG4 codec, if it is not et installed on your system. mioad codec
Single Channel
Search |
Camera Begin Date: 11152010 [~ BeginTime: 14702PM =
' ATVAP1IOWN(192.168.4.77) »| EndDete: 111162010 I~ EndTme: 14702PM =
Search
Record File Playback

C\\Video Data\CH120101111161Ch1_2010.1" »
C:\\Video Data\CH1\2010\11\161Ch1_2010.1°
G:\\Video Data\CH1\2010\111161Ch1_2010.1°

\\Video Data\CH12010\111161Ch1_2010.1"
C/\\Video Data\CH120101111161Ch1_2010.1°

C\IVideo DatalCH1\2010i111161Ch1 2010 1 :
C:\iVideo DatalCH1\20101111161Ch12010.1°

C:\IVideo DatalCH1\2010i111161Ch1_2010.1° fl
C:\\Video DatalCH1\2010111\161Ch1_2010.1° I

C \IVideo DatalCH1120101111161Ch12010 1-
C\iVideo Data\CH1\20101111161Ch12010.11
ideo DatalCH1120101111161Ch1_2010.1

‘ m '
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5.2.4 eMap Setup & Camera Status

B Manage eMap

Click the button and select View Setting to manage eMap.

| view Setting

ehtap View

Camera Status

eMap refers to the geography and device scope in the SecurView
Pro, which visually presents the devices in your security system. It
uses a background of the area (e.g. a picture or a map) as the
interface for monitoring.

To add an eMap

1. On the View Setting window, click New.

5 View Setting ==

View > View Sefing
eMap

eMap List

eMap Name Image §
L New |

| Modify
[Remova |

Browse

Save Cancel
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2. Enter an eMap name.

T —— |
View > View Seting |
eMap
eMap List
e ()
Remaove
eMap Information
‘aMap Name. Preview
Home]
T
[[Browse |
Save Cancel

3. Click Browse to select a Picture File from your computer.
Picture will display in the Preview window.

p— )
View > View Setting
eMap
eMap List
s [ |
Modify
‘eMap Information
‘eMap Name:
Home
Image File
C:\
[sae ] [Concel]

-79 -



4. Click Save and click OK to apply the settings.

X |

Image
CWsersiMichelleDesktop\New folder (2)ieMa
Modify
[Remove |

eMap Information

C-Wsers\Michelle\Desktop\New fol

(] (el

5. Click Camera Location to assign the camera location.

-
View > View Setting i
eMap |
eMap List
‘eMap Name Image
Home

‘eMap Information
‘eMap Name:
Home

Image File:

Ci\UsersiMichelie\Desktop\New foider| | Browse

Save Camera Location
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6. The following screen appears.

[01TVAPTIOWN
02TVAP121W
03 TVAP410W
04TVAP110
05TVAP252P

* Select a camera from the camera list and then click on the desired camera position on the map to place the ca)
* Ciick on the camera icon on the map to remove it from the map.

o] [oen |

7. Select the camera from the list and then click the position on

the map. The camera icon mwill be displayed on map.

Camera List: MAP Name:

05TVIP252P

* Select a camera from the camera kst and then click on the desired camera position on the map to place the caf
* Ciick on the camera icon on the map to remove it from the map.

[Csae ] [Cosck ]
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8. Click Save when complete.

il 2 Mp 200 G313 pesion

Camera List MAP Name.

* Chick on the camera icon on the map to remove it from the map.

(T

* Select a camera from the camera list and then click on the desired camera position on the map to place the cal

| Back

To modify/remove an eMa

To edit the eMap: In the eMap List, select the map name from

eMap list, and click Modify.

The map’s information will display on the preview windows. After
changes the setting information, click Save to save the setting.

[ eMap Name Image
Home

eMap Information
eMap Name
Home

Image File

CUsersWichele\Deskiopiew folder [ Browse |

Y e -
View > View Sefting |
eMap |

oMap List

-82-



2. To delete the eMap: In the eMap List, select the desired one and
click Remove. The selected map will be removed from the list.

e e | — e i
View > View Setting
ahap l
eMap List
aMap Name Image
New |
Modify |

Remove ]

Browse

Save Cancel

=

B View eMap

a. Click the button and select eMap View.

|

Camera Status
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b. Select the map from the eMap Name list.

SecurView
PRO

11/16/2010
14:41:27

Camera Status Click the camera icon @, the camera Live
Monitor window will display live image on that camera.

*

SecurView
PRO

11/16/2010
14:46:05

‘ .C1.256GB,

0006 C =
() GRS -
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5.2.5 System Info

B Account

Click the @ System button and select Account to change the
administrator password of the system.

Version
System Setting

Enter the Current password, and then enter the new password
twice (in the Type new password and Retype password boxes).
Then click Save.

& X

System > Account Sefting

Administrator

Current password:

Type new password:

Retype password:

Save Cancel
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B Version

Click the @ System button and select Version to view the
current firmware version of the system.

a SystemVersi

System > Version

SecurView Pro

Version XXX

Last Update:  XX/XX/XXXX

Warning: This computer program is protected by copyright law and
international treaties. Unauthorized reproduction or distribution of this
program, or any portion of it, or the use with a registration key without the:
explicit permission may result in severe criminal and civil penalties, and will
be prosecuted to the maximum extent possible under law.

B System Setting

Click the @ System button and select System Setting. Auto Scan
period can be set from 30 seconds to 100 seconds.

System > System Setting
Auto Scan time interval: |30 ~| Seconds

[] Start the software when windows start
[] Auto login

-86 -



5.2.6 Event Settings

B Setting up Event Server

Click the @ button and select Event Server to configure the
SMTP settings for email notification use.

Event Server

Address Book

Event Trigger

| o' Event Server,

| Event > Event Server

| SMTP
Enable SMTP
I SMTP Server Addr mailserver.com

Sender Email Addr john@mailserver.com

Authentication Mod”) None @ SMTP I
Sender User Namejohn I

W
Sender Password: =======rrrrres

Port Number: 25

[ sSL

[ Save ] [Cam:el] [Remwe]

Select the Enable SMTP option and configure the following
information correctly to start the email feature.
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® SMTP Server Address: Enter the mail server address.
For example, mymail.com or smtp.gmail.com or
smtp.live.com

® Sender Email Address: Enter the email address of the user
who will send the email. For example, John@mailserver.com.

® Authentication Mode: Select None or SMTP according to the
mail server configuration.

® Sender User Name: Enter the user name to login the mail
server.

Sender Password: Enter the password to login the mail server.

Port Number: Enter the port number used for the email
server.

® SSL: If the mail server requires an encrypted connection, you
should check the SSL option. For example, gmail users, please
select this option.

When completed, click Save and then select OK. The system will
automatically start the Event Service.

TIP The status of Event Service is indicated by the [* icon in the system bar.
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B Sending Notification to the User

Click the @ button and select Address Book to assign the user
to the Address Book of the camera. The user will receive a real-
time notification from the system while triggering out.

Event Server

Address Book I

Event Trigger

54 Address Bool i
Event > Address Book
Address Book List
|
Lst | Name Email
John john@mailserver com
l New |
Modify |

Address Book Information

Name: Mary

Email: mary@hotmail.com

Save | Cancel |

1. Onthe Address Book window, click New.

2. Inthe Address Book Information field, enter the Name and
Email of the user.

3. When completed, click Save. The user will be displayed in the
Address Book List.
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4. To edit the user: In the Address Book List, select the desired
user and click Modify. The user’s information will be
displayed, where you can change the user’s information and
then click Save when completed.

5. To delete the user: In the Address Book List, select the
desired user and click Remove. The selected user will be
removed from the list.

B Configuring Event Trigger

Click the @ button and select Event Trigger to configure the
trigger out function of the camera.

Event Server
Address Book

| Event Trigger

)

—

)

2

o vt Tgger,

B

C.

Camera List

Name

VIR
VIRt
TVIP4
TVIP1
VP2

=
Event > Event Trigger

IPaddress  Port

182 168.1
182 1681
182 1681
192 168 1
192 168 1

80
919
918
921
919

Trigger Setling

Add Address Book

SMTP  Address Book List

Name

Subject

Message

Play Sound

eMap Popuf

Email

Browse

Save Cancel

Test
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1. Onthe Event Trigger window, select the desired camera from
the Camera List.

2. Do one of the following:

B SMTP: Select this option and enter the Subject and
Message, the system will send an email message to the
selected user(s) in the Address Book List.

B Play Sound: Select this option select a sound file from the
computer, so that the system will alarm by the sound
while triggering out.

B eMap Popup: Select this option and select the eMap
profile from the pull-down menu. The camera view of the
eMap will be displayed while triggering out.

5.2.7 Close Program

When you have finished operating, click the W putton and select Logout
to logout the system or Close to exit the program.

Logout

Close |

b
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CHAPTER 6

How to access the camera behind a Router

You can either setup the Dynamic DNS connection via camera itself or your
home router. An account from any of the listed DDNS providers is required
prior to this operation.

Configure DDNS on your Camera

1. Goto Camera’s DDNS Setting page, click Enable to activate
the feature. Then select a DDNS provider from the list.

DDNS Setting: Enable
Provider www.dyndns.com M
d
Host Name: members.easydns.com

web.easydns.com
www.EuroDynDNS.org
www_no-ip.com

www ovh com

User Name:

Password:

www regfish com

2. Enter your DDNS’s the Host Name, User Name and Password.

DDNS Setting: Enabile
Provider: www_dyndns_com -
Host Name trendnet dyndns_org
User Name trendnet
Password: LLITI I T
UPnP: Enable
Ports Number:
HTTP Port: 9000 (default: 80)
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In the Port Number section, assign an HTTP port of the
camera. The default HTTP Port on the camera is 80. The
example shows above is using port number 9000.

Open another web browser and go to your Router’s Web
Configuration page. (In the example, TRENDnet’s TEW-651BR
Wireless N router is used)

@ TREnDnET 150Mbps Wireless N Home Router

TEW-651BR

Main .
Virtual Server
Wireless

Status Enable| ©/ Enable @ Disabled

N
Routing ame

Protocol

ccess
Private Port
« Filter

+ Virtual Server Public Port

« Special AP LAN Server

.
+ Firewall Rule
e

Management

Name Protocol
Tools

Virtual Server FTP TCP 21121

Wizard Virtual Server HTTP TCP 80/80

Virtual Server HTTPS TCP 443/443

Virtual Server DNS UDP 53/53

Virtual Server SMTP TCP 25125

Virtual Server POP3 TCP 1101110

Virtual Server Telnet TCP 23/23

PPTP TCP 17231723

NetMeeting TCP 17201720

Copyright © 2008 TRENDnet. All Rights Reserved.

Go to Virtual Server* section and create a new entry.

Enable: Click Enable
Name: Enter the application name (eg. CameraName)
Protocol: Select TCP
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Private Port: The HTTP port that you assign on your Camera.
Public Port: The port used on remote side to access to your
Camera.

LAN Server: The local IP address of your Camera.

Virtual Server

Enable| ‘@' Enable Disabled

Name| IP Camera

Protocol| TCP +

Private Port | S000

Public Port | 000

LAN Server| 192.168.1.101

Then click Add to add the application.

* Please refer to your router’s user’s manual for detail Virtual
Server setting. Some router might use Port Forwarding or
Special applications for this function. The setup steps should

be very similar.

Name Protocol LAN Server
Virtual Server FTP TCP 21121 0.000
Virtual Server HTTP TCP 80/80 0000
Virtual Server HTTPS TCP 443/443 0000
Virtual Server DNS UDP 53/53 0000
Virtual Server SMTP TCP 2525 0000
Virtual Server POP3 TCP 110/110 0000
Virtual Server Telnet TCP23/23 0.000
PPTP TCP 172311723 0000
NetMeeting TCP 172011720 0000
IP Camera TCP 9000/9000 192.168.1.101

94 -
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6. Open another web browser and enter your DDNS domain and
camera’s port number.

http://yourDomainName:PortNumber

e New Tab - Windows Internet Explorer

e http://trendnet.dyndns.org:9000|

e

7. Camera’s login page will appear.

Configure DDNS on your router

1. Goto Camera’s DDNS = Ports Number section, assign a
HTTP port for your camera and click Apply.

DDNS Setting: [C] Enable
Provider: wuw dyndns com e
Host Name:
User Name:
Password:
UPnP: [C] Enable
Ports Number: HTTP Port: 90000 (default 80)

2. Login to your router’s web configuration page.
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http://yourDomainName:PortNumber

3. Find the Dynamic DNS configuration section.

@ TREnDnET 150Mbps Wireless N Home Router

TEW-651BR

am

« LAH & DHCP Server Dynamic DNS Help

- WAN

DDNS | ) Enabled @ Disabled
« Password

- Time Server Address | | DynDns com =

+ Dynamic DNS
Host Hame

Wireless
User Name

Status
Password

Routing

Access
Management
Tools

Wizard

Copyright © 2009 TRENDnet. All Rights Reserved.

4. Enable DDNS, fill out the following information and then click
Apply.

Dynamic DNS

DDNS | @ Enabled () Disabled

Server Address | DynDns.com ~

Host Name | trendnet.dyndns.org

User Name | trendnet

P d 1

-96 -



5.

7.

Go to Virtual Server* section and create a new entry.
Enable: Click Enable

Name: Enter the application name (eg. Camera Name)
Protocol: Select TCP

Private Port: The HTTP port that you assign on your Camera.
Public Port: The port used on remote side to access to your
Camera.

LAN Server: The local IP address of your Camera.

Virtual Server T —

Enable| '@ Enable Disabled

Name| IP Camera

Protocol| TCP ~

Private Port | 9000

Public Port | 9000

LAN Server| 192.168.1.101

—_—

Click Add to add the application.

* Please refer to your router’s user’s manual for detail Virtual
Server setting. Some router might use Port Forwarding or
Special applications for this function. The setup steps should
be very similar.

Open another web browser and enter your DDNS domain and
camera’s port number.
http://yourDomainName:PortNumber

e New Tab - Windows Internet Explorer

e http://trendnet.dyndns.org:QOOOI

The camera login page will appear.
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CHAPTER 7

APPENDIX

A.1 Specification

Camera

General

Sensor: 1/4” color CMOS sensor
Resolution: 640 x 480 pixels

Board Lens

Focal Length: 5.0mm

Aperture (F/No): F2.8

Minimum illumination: 1 Lux
Diagonal viewing angle: 52 degrees

Image & Video

Compression: MJPEG

Exposure/white balance/Gain Control : automatic
Resolution: up to 25fps for VGA (640x480), 25fps for QVGA
(320x240), 25fps for QQVGA (160x120)

Audio

Built-in omni-directional microphone
Sensitivity: -48dB +/- 3dB (5 meters max.)
Frequency: 50~16000Hz

Hardware

Network

IEEE 802.3u 10/100Mbps Fast Ethernet, Auto-MDIX

LED

Power, Link

Reset Button

Restore to factory default

Power Consumption

5 Watts

Power

5V, 2.5A external power adapter

Dimension
70 x 100 x 57mm (2.7 x3.9x 3.01in.)
Weight Camera: 155g (5.5 oz.)
Stand: 135g (4.8 oz.)
Temperature Operating: 0°C ~ 45°C (32°F ~ 113°F)
Storage: -15°C ~ 60°C (5°F ~ 140°F)
Humidity Max. 90% (non-condensing)

Certifications

CE, FCC

Requirement

Management Interface

Internet Explorer 6.0 or above

To Run SecurView Pro

Windows 7 (32/64-bit), Vista (32/64-bit), XP (32/64-bit)

SecurView Pro

Channel: supports up to 32 cameras
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Record/Playback/Motion Detection

Network Protocols

TCP/IP, UDP, ICMP, DHCP, NTP, DNS, DDNS, SMTP, FTP, HTTP,
PPPoE, UPnP and SSL

Wireless
Standard Based on IEEE 802.11n technology
IEEE 802.11g/b compliant
Frequency 2.4~ 2.4835GHz
Antenna 1 x 2dBi dipole antenna (Reverse-SMA connector)
Data Rate 802.11n: up to 150Mbps

(auto fallback)

802.11g: up to 54Mbps
802.11b: up to 11Mbps

Security

64/128-bit WEP, WPA/WPA2-PSK

Output Power

802.11n: 14 + 1 dBm
802.11b: 16 + 1 dBm
802.11g: 16 + 1 dBm

Receiving Sensitivity

802.11n HT20: -69dBm
802.11n HT40: -66dBm
802.11g: -73dBm
802.11b: -84dBm

Channel 1~11 (FCC), 1~13 (ETSI)

Management

Remote Remote management supported

Backup / Restore Save/retrieve configuration files

Settings

Recording Recording type: continuous, schedule or motion detection with

software

Port Settings

HTTP port: 80 (default)

Digital Zoom 3x

Dynamic DNS Yes

Time Synchronize with NTP server or set time/date manually
SMTP SMTP mail supported up to 2 accounts

System log 100 items
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A.2 Glossary of Terms

NUMBERS
10BASE-T

100BASE-TX

ADPCM

AMR

Applet

ASCII

ARP

AVl

BOOTP

(@]

10BASE-T is Ethernet over UTP Category lll, IV, or V
unshielded twisted-pair media.

The two-pair twisted-media implementation of 100BASE-T is
called 100BASE-TX.

Adaptive Differential Pulse Code Modulation, a new
technology improved from PCM, which encodes analog
sounds to digital form.

AMR (Adaptive Multi-Rate) is an audio data compression
scheme optimized for speech coding, which is adopted as the
standard speech codec by 3GPP.

Applets are small Java programs that can be embedded in an
HTML page. The rule at the moment is that an applet can only
make an Internet connection to the computer form that the
applet was sent.

American Standard Code For Information Interchange, it is the
standard method for encoding characters as 8-bit sequences
of binary numbers, allowing a maximum of 256 characters.

Address Resolution Protocol. ARP is a protocol that resides at
the TCP/IP Internet layer that delivers data on the same
network by translating an IP address to a physical address.

Audio Video Interleave, it is a Windows platform audio and
video file type, a common format for small movies and videos.

Bootstrap Protocol is an Internet protocol that can
automatically configure a network device in a diskless
workstation to give its own IP address.
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Communication

Connection

DHCP

DNS

E

Enterprise network

Communication has four components: sender, receiver,
message, and medium. In networks, devices and application
tasks and processes communicate messages to each other
over media. They represent the sender and receivers. The
data they send is the message. The cabling or transmission
method they use is the medium.

In networking, two devices establish a connection to
communicate with each other.

Developed by Microsoft, DHCP (Dynamic Host Configuration
Protocol) is a protocol for assigning dynamic IP addresses to
devices on a network. With dynamic addressing, a device can
have a different IP address every time it connects to the
network. In some systems, the device's IP address can even
change while it is still connected. It also supports a mix of
static and dynamic IP addresses. This simplifies the task for
network administrators because the software keeps track of
IP addresses rather than requiring an administrator to
manage the task. A new computer can be added to a network
without the hassle of manually assigning it a unique IP
address. DHCP allows the specification for the service
provided by a router, gateway, or other network device that
automatically assigns an IP address to any device that
requests one.

Domain Name System is an Internet service that translates
domain names into IP addresses. Since domain names are
alphabetic, they're easier to remember. The Internet
however, is really based on IP addresses every time you use a
domain name the DNS will translate the name into the
corresponding IP address. For example, the domain name
www.network_camera.com might translate to 192.167.222.8.

An enterprise network consists of collections of networks
connected to each other over a geographically dispersed area.
The enterprise network serves the needs of a widely
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Ethernet

F

Fast Ethernet

Firewall

G

Gateway

Group

H
HEX

distributed company and operates the company’s mission-
critical applications.

The most popular LAN communication technology. There are
a variety of types of Ethernet, including 10Mbps (traditional
Ethernet), 100Mbps (Fast Ethernet), and 1,000Mbps (Gigabit
Ethernet). Most Ethernet networks use Category 5 cabling to
carry information, in the form of electrical signals, between
devices. Ethernet is an implementation of CSMA/CD that
operates in a bus or star topology.

Fast Ethernet, also called 100BASE-T, operates at 10 or
100Mbps per second over UTP, STP, or fiber-optic media.

Firewall is considered the first line of defense in protecting
private information. For better security, data can be
encrypted. A system designed to prevent unauthorized access
to or from a private network. Firewalls are frequently used to
prevent unauthorized Internet users from accessing private
networks connected to the Internet, especially Intranets all
messages entering or leaving the intranet pass through the
firewall, which examines each message and blocks those that
do not meet the specified security criteria.

A gateway links computers that use different data formats
together.

Groups consist of several user machines that have similar
characteristics such as being in the same department.

Short for hexadecimal refers to the base-16 number system,
which consists of 16 unique symbols: the numbers 0 to 9 and
the letters A to F. For example, the decimal number 15 is
represented as F in the hexadecimal numbering system. The
hexadecimal system is useful because it can represent every
byte (8 bits) as two consecutive hexadecimal digits. It is easier
for humans to read hexadecimal numbers than binary
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Intranet

Internet

Internet address

IP address

ISP

(5

JAVA

numbers.

This is a private network, inside an organization or company
that uses the same software you will find on the public
Internet. The only difference is that an Intranet is used for
internal usage only.

The Internet is a globally linked system of computers that are
logically connected based on the Internet Protocol (IP). The
Internet provides different ways to access private and public
information worldwide.

To participate in Internet communications and on Internet
Protocol-based networks, a node must have an Internet
address that identifies it to the other nodes. All Internet
addresses are IP addresses

Internet Protocol is the standard that describes the layout of
the basic unit of information on the Internet (the packet) and
also details the numerical addressing format used to route the
information. Your Internet service provider controls the IP
address of any device it connects to the Internet. The IP
addresses in your network must conform to IP addressing
rules. In smaller LANs, most people will allow the DHCP
function of a router or gateway to assign the IP addresses on
internal networks.

IP address is a 32-binary digit number that identifies each
sender or receiver of information that is sent in packets across
the Internet. For example 80.80.80.69 is an IP address. When
you “call” that number, using any connection methods, you
get connected to the computer that “owns” that IP address.

ISP (Internet Service Provider) is a company that maintains a
network that is linked to the Internet by way of a dedicated
communication line. An ISP offers the use of its dedicated
communication lines to companies or individuals who can’t
afford the high monthly cost for a direct connection.

Java is a programming language that is specially designed for
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writing programs that can be safely downloaded to your
computer through the Internet without the fear of viruses. It
is an object-oriented multi-thread programming best for
creating applets and applications for the Internet, Intranet
and other complex, distributed network.

Local Area Network a computer network that spans a
relatively small area sharing common resources. Most LANs
are confined to a single building or group of buildings.

MJPEG (Motion JPEG) composes a moving image by storing
each frame of a moving picture sequence in JPEG
compression, and then decompressing and displaying each
frame at rapid speed to show the moving picture.

MPEG4 is designed to enable transmission and reception of
high-quality audio and video over the Internet and next-
generation mobile telephones.

Network Address Translator generally applied by a router that
makes many different IP addresses on an internal network
appear to the Internet as a single address. For routing
messages properly within your network, each device requires
a unique IP address. But the addresses may not be valid
outside your network. NAT solves the problem. When devices
within your network request information from the Internet,
the requests are forwarded to the Internet under the router's
IP address. NAT distributes the responses to the proper IP
addresses within your network.

A network consists of a collection of two or more devices,
people, or components that communicate with each other
over physical or virtual media. The most common types of
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network are:

LAN — (local area network): Computers are in close distance to
one another. They are usually in the same office space, room,
or building.

WAN — (wide area network): The computers are in different
geographic locations and are connected by telephone lines or
radio waves.

A network protocol that can automatically negotiate the
highest possible transmission speed between two devices.

PCM (Pulse Code Modulation) is a technique for converting
analog audio signals into digital form for transmission.

Packet Internet Groper, a utility used to determine whether a
specific IP address is accessible. It functions by sending a
packet to the specified address and waits for a reply. It is
primarily used to troubleshoot Internet connections.

Point-to-Point Protocol over Ethernet. PPPoE is a specification
for connecting the users on an Ethernet to the Internet
through a common broadband medium, such as DSL or cable
modem. All the users over the Ethernet share a common
connection.

Communication on the network is governed by sets of rules
called protocols. Protocols provide the guidelines devices use
to communicate with each other, and thus they have different
functions. Some protocols are responsible for formatting and
presenting and presenting data that will be transferred from
file server memory to the file server’s net work adapter
Others are responsible for filtering information between
networks and forwarding data to its destination. Still other
protocols dictate how data is transferred across the medium,
and how servers respond to workstation requests and vice
versa. Common network protocols responsible for the
presentation and formatting of data for a network operating
system are the Internetwork Packet Exchange (IPX) protocol
or the Internet Protocol (IP). Protocols that dictate the format
of data for transferors the medium include token-passing and
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Carrier Sense Multiple Access with Collision Detection
(CSMA/CD), implemented as token-ring, ARCNET, FDDI, or
Ethernet. The Router Information Protocol (RIP),a part of the
Transmission Control Protocol/Internet Protocol (TCP/IP)
suite, forwards packets from one network to another using
the same network protocol.

RJ-45 connector is used for Ethernet cable connections.

A router is the network software or hardware entity charged
with routing packets between networks.

RTP (Real-time Transport Protocol) is a data transfer protocol
defined to deliver live media to the clients at the same time,
which defines the transmission of video and audio files in real
time for Internet applications.

RTSP (Real-time Streaming Protocol) is the standard used to
transmit stored media to the client(s) at the same time, which
provides client controls for random access to the content
stream.

It is a simple computer that provides resources, such as files
or other information.

SIP (Session Initiated Protocol) is a standard protocol that
delivers the real-time communication for Voice over IP (VolP),
which establishes sessions for features such as audio and
video conferencing.

The Simple Mail Transfer Protocol is used for Internet mail.
Simple Network Management Protocol. SNMP was designed

to provide a common foundation for managing network
devices.

In LANSs, a station consists of a device that can communicate
data on the network. In FDDI, a station includes both physical
nodes and addressable logical devices. Workstations, single-
attach stations, dual-attach stations, and concentrators are
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FDDI stations.

In TCP/IP, the bits used to create the subnet are called the
subnet mask.

Transmission Control Protocol/Internet Protocol is a widely
used transport protocol that connects diverse computers of
various transmission methods. It was developed y the
Department of Defense to connect different computer types
and led to the development of the Internet.

A transceiver joins two network segments together.
Transceivers can also be used to join a segment that uses one
medium to a segment that uses a different medium. On a
10BASE-5 network, the transceiver connects the network
adapter or other network device to the medium. Transceivers
also can be used on 10BASE-2 or 10BASE-T networks to attach
devices with AUl ports.

The User Datagram Protocol is a connectionless protocol that
resides above IP in the TCP/IP suite

The USERNAME is the unique name assigned to each person
who has access to the LAN.

It is a program that performs a specific task.

Unshielded twisted-pair. UTP is a form of cable used by all
access methods. It consists of several pairs of wires enclosed
in an unshielded sheath.

Wide-Area Network. A wide-area network consists of groups
of interconnected computers that are separated by a wide
distance and communicate with each other via common
carrier telecommunication techniques.

WEP is widely used as the basic security protocol in Wi-Fi
networks, which secures data transmissions using 64-bit or
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Windows

WPA

WPA2

128-bit encryption.

Windows is a graphical user interface for workstations that
use DOS.

WPA (Wi-Fi Protected Access ) is used to improve the security
of Wi-Fi networks, replacing the current WEP standard. It uses
its own encryption, Temporal Key Integrity Protocol (TKIP), to
secure data during transmission.

Wi-Fi Protected Access 2, the latest security specification that
provides greater data protection and network access control
for Wi-Fi networks. WPA2 uses the government-grade AES
encryption algorithm and IEEE 802.1X-based authentication,
which are required to secure large corporate networks.
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Limited Warranty

TRENDnet warrants its products against defects in material and
workmanship, under normal use and service, for the following lengths of
time from the date of purchase.

TV-IP110WN — 3 Years Limited Warranty

Camera’s motor, AC/DC Power Adapter, Cooling Fan, and Power Supply
carry 1 year warranty.

If a product does not operate as warranted during the applicable warranty
period, TRENDnet shall reserve the right, at its expense, to repair or
replace the defective product or part and deliver an equivalent product or
part to the customer. The repair/replacement unit’s warranty continues
from the original date of purchase. All products that are replaced become
the property of TRENDnet. Replacement products may be new or
reconditioned. TRENDnet does not issue refunds or credit. Please contact
the point-of-purchase for their return policies.

TRENDnet shall not be responsible for any software, firmware,
information, or memory data of customer contained in, stored on, or
integrated with any products returned to TRENDnet pursuant to any
warranty.

There are no user serviceable parts inside the product. Do not remove or
attempt to service the product by any unauthorized service center. This
warranty is voided if (i) the product has been modified or repaired by any
unauthorized service center, (ii) the product was subject to accident,
abuse, or improper use (iii) the product was subject to conditions more
severe than those specified in the manual.

Warranty service may be obtained by contacting TRENDnet within the

applicable warranty period and providing a copy of the dated proof of the

purchase. Upon proper submission of required documentation a Return
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Material Authorization (RMA) number will be issued. An RMA number is
required in order to initiate warranty service support for all TRENDnet
products. Products that are sent to TRENDnet for RMA service must have
the RMA number marked on the outside of return packages and sent to
TRENDnet prepaid, insured and packaged appropriately for safe shipment.
Customers shipping from outside of the USA and Canada are responsible
for return shipping fees. Customers shipping from outside of the USA are
responsible for custom charges, including but not limited to, duty, tax, and
other fees.

WARRANTIES EXCLUSIVE: IF THE TRENDNET PRODUCT DOES NOT
OPERATE AS WARRANTED ABOVE, THE CUSTOMER’S SOLE REMEDY SHALL
BE, AT TRENDNET'S OPTION, REPAIR OR REPLACE. THE FOREGOING
WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ALL
OTHER WARRANTIES, EXPRESSED OR IMPLIED, EITHER IN FACT OR BY
OPERATION OF LAW, STATUTORY OR OTHERWISE, INCLUDING
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. TRENDNET NEITHER ASSUMES NOR AUTHORIZES ANY OTHER
PERSON TO ASSUME FOR IT ANY OTHER LIABILITY IN CONNECTION WITH
THE SALE, INSTALLATION MAINTENANCE OR USE OF TRENDNET'S
PRODUCTS.

TRENDNET SHALL NOT BE LIABLE UNDER THIS WARRANTY IF ITS TESTING
AND EXAMINATION DISCLOSE THAT THE ALLEGED DEFECT IN THE
PRODUCT DOES NOT EXIST OR WAS CAUSED BY CUSTOMER’S OR ANY
THIRD PERSON’S MISUSE, NEGLECT, IMPROPER INSTALLATION OR
TESTING, UNAUTHORIZED ATTEMPTS TO REPAIR OR MODIFY, OR ANY
OTHER CAUSE BEYOND THE RANGE OF THE INTENDED USE, OR BY
ACCIDENT, FIRE, LIGHTNING, OR OTHER HAZARD.

LIMITATION OF LIABILITY: TO THE FULL EXTENT ALLOWED BY LAW
TRENDNET ALSO EXCLUDES FOR ITSELF AND ITS SUPPLIERS ANY LIABILITY,
WHETHER BASED IN CONTRACT OR TORT (INCLUDING NEGLIGENCE), FOR
INCIDENTAL, CONSEQUENTIAL, INDIRECT, SPECIAL, OR PUNITIVE DAMAGES
OF ANY KIND, OR FOR LOSS OF REVENUE OR PROFITS, LOSS OF BUSINESS,
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LOSS OF INFORMATION OR DATE, OR OTHER FINANCIAL LOSS ARISING OUT
OF OR IN CONNECTION WITH THE SALE, INSTALLATION, MAINTENANCE,
USE, PERFORMANCE, FAILURE, OR INTERRUPTION OF THE POSSIBILITY OF
SUCH DAMAGES, AND LIMITS ITS LIABILITY TO REPAIR, REPLACEMENT, OR
REFUND OF THE PURCHASE PRICE PAID, AT TRENDNET'S OPTION. THIS
DISCLAIMER OF LIABILITY FOR DAMAGES WILL NOT BE AFFECTED IF ANY
REMEDY PROVIDED HEREIN SHALL FAIL OF ITS ESSENTIAL PURPOSE.

Governing Law: This Limited Warranty shall be governed by the laws of the
state of California.

Some TRENDnet products include software code written by third party
developers. These codes are subject to the GNU General Public License
("GPL") or GNU Lesser General Public License ("LGPL").

Go to http://www.trendnet.com/gpl or http://www.trendnet.com
Download section and look for the desired TRENDnet product to access to
the GPL Code or LGPL Code. These codes are distributed WITHOUT
WARRANTY and are subject to the copyrights of the developers. TRENDnet
does not provide technical support for these codes. Please go to
http://www.gnu.org/licenses/gpl.txt or
http://www.gnu.org/licenses/Igpl.txt for specific terms of each license.
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